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About This Book 

This guide provides a detailed description of how to use the Freescale 802.15.4/Zigbee 

Evaluation Kit (13193EVK), part number 13193EVK-A00. 

The 13193EVK provides a flexible demonstration and development environment for the 

Freescale ZigBee family of products.  In addition to the hardware, the kit provides utilities and 

sample applications that demonstrate functionality from simple proprietary applications, 

802.15.4 applications, all the way to full ZigBee compatible solutions. 

Audience 
This document is intended for application developers.  

Organization 
This document is organized into 6 chapters. 

Chapter 1 Safety Information — This chapter provides operating guidelines for 

the 13193EVK. 

Chapter 2 13193EVK Components — This chapter gives an overview of the 

13193EVK and its components. 

Chapter 3 Board Overview — This chapter describes the boards that ship with the 

13193EVK. 

Chapter 4 Software Installation — This chapter describes how to install the 

software found on the 13193EVK CD. 

Chapter 5 Demonstration Applications — This chapter describes the various 

demonstration applications pre-loaded on the boards. 

Chapter 6 Solution Development — This chapter shows users how to begin 

development of an MC13192 system solution.  
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Conventions 
This document uses the following notational conventions: 

• Courier monospaced type indicates commands, command parameters, code examples, 

expressions, data types, and directives. 

• Italic type indicates replaceable command parameters. 

• All source code examples are in C. 

Definitions, Acronyms, and Abbreviations 
BDM debugger A debugger using the BDM interface for communication with the MCU. 

An example is the P&E BDM Multilink debugger for HCS08. 

BDM Background Debug Module 

13193EVK The 802.15.4/Zigbee Evaluation Kit 

GUI Graphical User Interface 

MAC  Medium Access Control 

MCU MicroController Unit 

NVM None-Volatile Memory 

PC Personal Computer 

PCB Printed Circuit Board 

S19 ‘S19’ is the file extension used for the Motorola binary image format. The 

S19 file encapsulates the binary image as a list of ASCII records. Each 

record contains a length -, address -, data - and checksum field. The 16 bit 

address field allows a memory space for up to 64 KB. The S19 can be 

generated with Metroworks Codewarrior IDE and is the product from the 

linking process. S19 does not contain additional information to a debugger 

(where to look for source files). 

Safe Mode Boot The Embedded Bootloader boots up using safe default system values. 

HIWAVE P&E HCS08 debugger GUI. 

CPROG P&E HCS08 flash programming tool called from HIWAVE. The tool is 

also available in a command line version where scripts can be made. 
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Chapter 1 
Safety Information 

Any modifications to this product may violate the rules of the Federal Communications 

Commission and make operation of the product unlawful. 

47 C.F.R. Sec. 15.21 

This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 

against harmful interference in a residential installation. This equipment generates, uses and can 

radiate radio frequency energy and, if not installed and used in accordance with the instructions, 

may cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation.  If this equipment does cause harmful 

interference to radio or television reception, which can be determined by turning the equipment 

off and on, the user is encouraged to try to correct the interference by one or more of the 

following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

47 C.F.R. Sec.15.105(b) 

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled 

environment. The antenna(s) used for this equipment must be installed to provide a separation 

distance of at least 8 inches (20cm) from all persons. 

This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two 

conditions: 

1. This device may not cause harmful interference. 

2. This device must accept any interference received, including interference that may cause 

undesired operation. 

3. This device is susceptible to electrostatic discharge (ESD) and surge phenomenon.  
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Chapter 2 
13193EVK Components 

The boards shipped with the 13193EVK are delivered with pre-loaded demonstration 

applications.  More applications can be uploaded with either the Embedded Bootloader utility 

which is located in the Test Tool application, or with CodeWarrior using the USB Multilink 

programmer (provided).  The CodeWarrior CD requires that users register to get a 30-day 

evaluation key.  After that time, users must purchase a standard key to use the CodeWarrior 

Software.  See the CodeWarrior documentation for more detailed information. The CodeWarrior 

software is not required to run the demonstrations and utilities described in this guide. 

Some applications are board dependent and will only run on specific target boards. The 

13193EVK contains the 13192-EVB and the 13192-SARD boards. 

Demonstration applications for the 13192-EVB include, but are not limited to: 

• Range Test 

• Switch Demonstration  

• Wireless UART 

• Test Tool Utility 

• Protocol Test Client (PTC) Demonstration (pre-loaded) 

 

Demonstration applications for the 13192-SARD include, but are not limited to: 

• Accelerometer Application (pre-loaded) 

• Range Test 

• Switch Demonstration 

• Wireless UART  

• Test Tool Utility 

• Protocol Test Client (PTC) Demonstration 

Additional applications can be run with the Figure 8 Wireless Z-Stack software. For more 

information, refer to the Z-Stack Users Guide for the Freescale 13193EVK which is shipped with 

the 13193EVK. 
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2.1 13193EVK Contents 
Table 1.  shows the boards contained in the 13193EVK-A00 development kit. 

Table 1.  13193EVK Boards 
P/N Description QTY 

13192-EVB 802.15.4/ZigBee Evaluation Board 3 

13192-SARD 802.15.4/ZigBee Sensor Application Board 2 

• In addition to the boards, the kit contains the necessary power adapters, cables, and 

software.  See the packing list included with the kit for a complete list of contents.
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Chapter 3 
Board Overview 

The 13193EVK contains two different boards. 

1. 13192-EVB 

2. 13192-SARD 

These boards include the following on-board components except where noted otherwise: 

• MC13192 2.4GHz transceiver 

• MC9S08GT60 Micro Controller Unit (MCU) 

• MMA6261Q accelerometer (13192-SARD only) 

• MMA1260D accelerometer (13192-SARD only) 

3.1 Common Board Components 

3.1.1 MC9S08GT60 MCU 
The MC9S08GT60 MCU is contained on both the 13192-SARD and 13192-EVB. The 

MC9S08GT60 MCU is a member of Freescale’s 8 bit, low cost, low power family of HCS08 

MCUs.  It has 60KB of embedded flash and 4KB of RAM.  For more information, refer to the 

MC9S08GB60 data sheet, at www.freescale.com/mcu. 

3.1.2 MC13192 RF Data Modem 
The MC13192 is contained on both the 13192-SARD and 13192-EVB. The MC13192 is an 

802.15.4 compliant, ZigBee-ready transceiver. It has a four-wire SPI interface to connect to a 

variety of microcontrollers, creating a low power, low cost solution for a range of applications. 

For more information on the MC13912, see the MC13192DS/D data sheet at 

www.freescale.com/ZigBee. 

3.1.3 MMA1260D and MMA6261Q Acceleration Sensors 
The MMA6261Q Acceleration Sensors are contained only on the 13192-SARD. The 

MMA1260D and the MMA6261Q Acceleration Sensors provide the 13192-SARD with unique 

applications to demonstrate wireless sensing solutions. For more information on the MMA1260D 

and the MMA6261Q, see the data sheets included with the 13193EVK CD or visit 

www.freescale.com/sensors. 
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3.2 13192-EVB Description 
The 13192-EVB is an 802.15.4/ZigBee evaluation board based on the MC13192, 2.4GHz 

transceiver and the MC9S08GT60 MCU.  The 13192-EVB board provides both serial and USB 

connectivity to a PC for easy evaluation.  It also includes the necessary circuitry to enable the 

MBC13900 Low Noise Amplifier (LNA) for improved sensitivity and range. It also has an 

external SMA connector for an external antenna connection which allows easy connectivity to a 

scope for test and measurement. 

The 13192-EVB contains the following interfaces 

• 1.1 USB port 

• RS232 Serial Connection 

• 4 push buttons (S1, S2, S3, S4) 

• 1 Reset button (Reset) 

• 4 LEDs, (LED1, LED2, LED3, LED4) 

• One power switch (S106) 

• Printed F antenna (Refer to AN2731/D for more information) 

• Optional MBC13900 LNA (disabled by default, visit www.freescale.com/rf for more 

information) 

• SMA RF connector (disabled by default) 

• Background Debug Module (BDM) connection (allows flash programming and in-circuit 

debug via the included USB Multilink Cable).  See USBMULTECHSUM/D document 

included in the kit for more details).  

• Power connector (5-9 Volts) 

• 10-pin header strip for access to specific MCU and RF pins 
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Figure 1 13192-EVB Block Diagram 

 

Figure 2 13192-EVB Board Layout 
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Table 2.  13192-EVB Board Labels 

Common Name Board Designation 

LED 1 LED1 

LED 2 LED2 

LED 3 LED3 

LED 4 LED4 

Button 1 S1 

Button 2 S2 

Button 3 S3 

Button 4 S4 

Reset Button Reset 

Power Toggle S106 

Switch S106 toggles power between the USB connector and the power connector. 

Refer to the MC13192 Evaluation Board Reference Manual, MC13192EVBRM/D for more info. 

3.3 13192-SARD Description 
The 13192-SARD is a demonstration board based on the MC13192 2.4GHz transceiver, 

MC9S08GT60 MCU, and the MMA6261Q and MMA1260D Acceleration Sensors. 

The 13192-SARD contains the following interfaces: 

• RS232 Serial Connection 

• 4 push buttons (S101, S102, S103, S104) 

• 1 Reset button (S106) 

• 4 LEDs (D101, D102, D103, D104) 

• One power switch (S105) 

• Printed Dipole antenna (Refer to AN2731/D for more information) 

• Background Debug Module (BDM) connection (allows flash programming and in-circuit 

debug via the included USB Multilink Cable).  See USBMULTECHSUM/D document 

included in the kit for more details).  

• Power Connections 

• Power connector (5.5-9 Volts) 

• 9-Volt battery connector 

• 3-Volt power connector (MMA1260D Acceleration Sensor disabled) 
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• 26-pin header strip (J105), for access to specific RF, MCU, and sensor pins  

 

Figure 3 13192-SARD Block Diagram 
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Figure 4 13192-SARD Board Layout 

Table 3.  13192-SARD Board Labels 
Common Name Board Designation 

LED 1 LED D101 

LED 2 LED D102 

LED 3 LED D103 

LED 4 LED D104 

Button 1 S101 

Button 2 S102 

Button 3 S103 

Button 4 S104 

Reset Button S106 

Power Switch S105 

See the SARD Users Guide, MC13192SARDUG/D for more information. 
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Chapter 4  
Software Installation 

This chapter describes how to install the software contained on the 13193EVK CD. Before 

connecting the hardware to the PC, the software on the 13193EVK CD must to be installed on a 

PC.  This installs the Test Tool application, object and source code, sample applications, and 

documentation. 

To install the software, perform the following steps. 

1. Insert the 13193EVK CD into your CD-ROM drive. 

2. If the program does not run automatically, run CDBrowser.exe from the Autorun directory. 

3. Select INSTALL/UNINSTALL from the menu options. The following window appears. 

 

 

Figure 5 Evaluation Kit CD Browser Main Window 
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4. Select the “Click here to Install/Uninstall” option. The following window appears. 

Figure 6 Installation Wizard Window 

5. Click on the “Next” button. The following window appears. 

Figure 7 Setup Type Window 

6. Select the “Typical” radio button and click on the “Next” button. Follow the directions in the 

InstallShield Wizard until the software installation is complete.  
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Chapter 5 
Demonstration Applications 

The 13192-EVB and 13192-SARD boards ship with several pre-loaded demonstration 

applications. This chapter describes how to run the included applications as well as loading and 

running additional applications included in the 13193EVK.   

This section uses the Test Tool’s Embedded Bootloader application to flash new firmware into 

the  

13192-SARD and 13192-EVB. The bootloader provides an alternative method to flash your 

applications with the need for a BDM cable. To flash the boards via the supplied BDM 

programmer and CodeWarrior, see the USBMULTILINK HCS08/HCS12 Technical Summary 

User Manual and the CodeWarrior™ Development Studio for 68HC08 Quick Start Guide. 

Flashing the board with the BDM programmer overwrites all code residing in the embedded 

flash including the Embedded Bootloader code.  In order to use the Embedded Bootloader utility 

to flash the board, you must reload the Embedded Bootloader code via the BDM. See the 

Embedded Bootloader Reference Manual (802154EMRM/D) for more details. 

NOTE 

Ensure that you have already installed the software from the  

13193EVK CD. (See Chapter 4 for more information.) 

The sample applications provided on the 13193 Evaluation Kit CD are based on Freescale’s 

Simple MAC (SMAC) and/or 802.15.4 MAC software.  For the ZigBee stack and application 

examples, see the Figure 8 Wireless Z-Stack CD included in the 13193EVK.   

The following applications are included on the 13193EVK CD. 

• SMAC Applications 

• Accelerometer Demonstration Application 

• Range Test 

• Additional SMAC based applications can be downloaded at 

www.freescale.com/ZigBee. 

 

• 802.15.4 Applications 

• PTC Demonstration 

• Switch Demonstration 

• Wireless UART 

 

• Windows Application 

• Test Tool 

• Command Console 

• Script Server 

• Embedded Bootloader 

• Radio Test 
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5.1 Accelerometer Demonstration Application (SMAC) 
The Accelerometer Demonstration is designed to run with 13192-SARD and is pre-flashed on 

the board.  The Accelerometer Demonstration Application uses two 13192-SARD boards that 

transmit X, Y, and Z-axis accelerometer data from 13192-SARD board one to 13192-SARD 

board two. The 13192-SARD board two is connected to a PC via a serial port.  The PC runs a 

GUI interface that displays the acceleration sensor data on the PC screen. The Accelerometer 

Demonstration application is optimized for low power consumption, not range evaluation. The 

output power on the Accelerometer Demonstration application is optimized for low power 

consumption and set below the nominal 0dBm level. To test the effective range of the boards, 

use the Range Demo Plus application, as described later in this chapter. 

5.1.1 Board Setup Overview 
To setup both boards for operation, (transmit and receive) perform the steps shown in this 

section. 

NOTE 

This section is based on the 13192-SARD board with the factory 

loaded Accelerometer Demonstration.  If you have re-flashed the 

13192-SARD board with another application, you will need to 

reload the Accelerometer Application.  See Section 5.8 for more 

information.  

5.1.2 Board One Setup (Transmit) 
1. Connect a 9V battery or the 9V power supply and set switch S105 to the “ON” position. 

2. While holding down button S101, press and release the Reset Button S106 then release S101.   

LED D104 should be blinking.  Board One is now in transmit mode. 

5.1.3 Board Two Setup (Receive) 
1. Connect the other 13192-SARD board to a PC’s serial port using a DB9 male/female serial 

cable included in the kit. 

2. Connect a 9V battery or the 9V power supply and set switch S105 to the “ON” position. 

3. Press the Reset Button S106.  Board Two is now in receive mode. 

5.1.4 Verifying Operation 
1. Verify that the boards are communicating by ensuring that LED D103 on the receive board 

(Board Two) is blinking.  If it is not, press the Reset Button S106 on Board Two again. (The 

board connected to the PC.) 
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5.1.5 Running the TRIAX Software 
1. Run the TRIAX Software from Windows Start menu ->Programs->Freescale->Triax. 

After execution of the Triax program, the software prompts users to select the proper 

communications port for their PC. This is the RS232 serial COM port to which the receiver 

board (Board One) is connected. 

5.1.6 Viewing Data 
After selecting the appropriate communications port, several methods are available to view the 

data being sent from the accelerometers on the transmitter board (Board One). 

1. Sensor Data – This application shows the raw data that is sent from the accelerometer and 

sampled by the MCU analog/digital converter.  The following data is provided. 

X, Y, and Z accelerometer analog outputs in volts. 

8-bit A/D readings (0-255). 

The output of each axis converted into g’s. 

2. G Mouse – This application displays the location of the board based on movement of the 

transmitter board (Board One).  To move the boxes on the display which represents the X, Y 

axis, pick up the transmitter board and tilt it through different angles. 

3. Tilt – This application translates the g’s experienced in each axis to an angle of rotation.  To 

view different angles, rotate/tilt the transmitter board. 

4. Shipping – This application timestamps when a pre-determined threshold is violated or when 

the board is turned upside down. 

NOTE 

If using batteries as the power source and the accelerometer 

demonstration behavior becomes erratic, replace the batteries. 

5.2 Range Demo Plus (SMAC) 
The Range Demo Plus is a simple application that transmits data from one board to the other.  

Signal strength is displayed via the LEDs on the board. This test can be performed on either the 

13192-SARD or the 13192-EVB. 

Before running the Range Demo Plus, the 13192-SARD board must be flashed with the 

following: 

• range_demo_plus_rx_13192SARD_loader.s19 

• range_demo_plus_tx_13192SARD_loader.s19  

Before running the Range Demo Plus, the 13192-EVB board must be flashed with the following: 

• range_demo_plus_rx_13192EVB_loader.s19 

• range_demo_plus_tx_13192SEVB_loader.s19   

Follow the instructions shown in Section 5.8.2 to flash the board using the Embedded 

Bootloader.  
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5.3 Embedded Bootloader 
The Embedded Bootloader allows users to flash the MCU on the 13192-EVB and 13192-SARD 

without the BDM programmer/debugger.  The Embedded Bootloader is located in a protected 

4KB flash block in the highest memory area (0xF000-0xFFFF) of the MC9S08GT60 MCU 

located on both the 13192-SARD and 13192-EVB boards. 

See the Embedded Bootloader Reference Manual (802154EBRM/D) for more information. 

5.3.1 Board One Setup (Receive) 
1. Connect a 13192-SARD or 13192-EVB to an RS232 serial COM port on the PC via the 

included serial cable. 

2. Connect a power source (9V battery or the 9V power supply to the board.  

3. Power on the board.  If all four LEDs are not on, press all four buttons (S101-S104 on the 

13192-SARD and S1-S4 on the 13192-EVB). The SMAC applications call the Embedded 

Bootloader with two buttons presses.  The 13192-SARD use S102 and S104 while the 

13192-EVB uses S2 and S4.  Press and release the Reset Button, then release the appropriate 

pushbuttons. All four LEDs should now be on. The board is now ready for flash 

programming. 

4. Run the “Test Tool” utility from the Start->Programs->Freescale Zigbee->Test Tool 

Windows menu. 

5. If running “Test Tool” for the first time, setup the board connection by selecting 

Communication Settings from the Tools menu as shown in Figure 8. From the “List of 

Devices” window, select the “Add Internal” option and click on the “Serial” button. Choose 

the appropriate Com Port and click on the “OK” button. 

Figure 8 Running Test Tool for the First Time 
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6. Click the “Close” button. 

7. From the Test Tool program, run the Embedded Bootloader application by selecting the 

“Embedded Bootloader” option from the “View” menu. 

8. Select the ZigBee device and click on the “OK” button. 

9. To flash the board for the Range Plus Demo, select the 

rx_range_demo_plus_13192SARD_SE_loader.s19 application file and click on the “Upload” 

button. 

If you receive a Timeout error, highlight the file and click on the “Upload” button again. 

10. While the board is flashed, a progress indicator appears in the Embedded Bootloader 

application. 

11. After the board is flashed, press the “Reset” button. 

5.3.2 Board Two Setup (Transmit) 
1. Connect the 13192-SARD or 13192-EVB to an RS232 serial COM port on the PC via the 

included serial cable. 

2. Connect a power source (9V battery or the 9V power supply) to the board.  

3. Power on the board.  If all 4 LEDs are not on, press and hold down all 4 buttons (S101-S104 

on the 13192-SARD and S1-S4 on the 13192-EVB) and press and release the Reset Button. 

Then release all four buttons. All four LEDs should be on and the board is ready for flash 

programming. 

4. Run the “Test Tool” utility from the Start->Programs->Freescale Zigbee->Test Tool 

Windows menu. 

5. From the “Test Tool” program, run the Embedded Bootloader application by selecting 

“Embedded Bootloader” option from the “View” menu. 

6. Select the ZigBee device and click on the “OK” button. 

7. To flash the board for the Range Plus Demo, select the 

tx_range_demo_plus_13192SARD_SE_loader.s19 application file and click on the “Upload” 

button. 

8. If you receive a Timeout error, highlight the file and click on the “Upload” button again. 

9. While the board is being flashed, a progress indicator appears in the Embedded Bootloader 

application. 

10. After the board is flashed, press and release the reset button. 

5.3.3 Verifying Operation 
Verify that the boards are communicating by ensuring that LED 1 on both boards is blinking.  

LEDs 2 through 4 are signal strength indicators. As the boards are moved further apart, LEDs 4 

through 2 will turn off in order.  When the range of the boards is exceeded, LED 1 stops 

blinking.  
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